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[[Lasteate YOUR OWN
CHILDREN'S BOOK
Tony Laidig

IN THIS TRAINING.

lllustrate Your OWN Children’s Book:
* The Biggest Challenge for ALL Children’s Authors.

* Understanding the Artistic Options You Likely Never
Considered.

* Planning Your lllustrations...Telling Your Story Visually.
* Photographs and How They Change the Rules.

« A Powerful Case Study You Can Use Immediately.
* And Much More!

Not long ago, it would have been impossible for me to entertain my passion for creating
children’s books. Like many of you, | would have been overwhelmed with the idea of finding
$10,000 to hire a professional illustrator to illustrate my book or have to settle for something
sub-standard, something less than the illustrations | would want in my book. But, I’'ve
developed some methods using photography, digital editing and “painting” techniques to
solve this problem and | think you are going to enjoy learning about it.

When you are looking at the prospect of creating a children’s book, you are probably thinking,
“The story will be easy to write, but how in the world am | going to portray this story in a way
that children will love?” I’'ve been in publishing for more than 20 years, working as a book and
cover designer. I’'ve learned a lot about writing and publishing books. | have 15 books I’'ve
written in various ways, shapes and forms. I’'m not going to say that the writing is easy, but
the biggest challenge with all children’s books is the illustrations. lllustrations are almost
always the stumbling block.
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Many years ago when | worked for a Christian publisher, we were always getting the latest
and greatest children’s books presented to us. We rejected nearly every one, not because the
story was bad or poorly written—some were wonderful stories—but because the books either
had no illustrations or the illustrations were not good quality. For the publishing company,
children’s books were not a safe enough bet to invest the thousands of dollars necessary to
create quality illustrations that would help ensure their success. Fortunately for us, print-on-
demand technology and digital books have changed that dynamic completely, putting the
tools back in the hands of anyone, author and illustrator. Consequently, the children’s book
market is exploding again.

If you want to now benefit from this exploding market and the power print on demand has
afforded you, there are some key issues with regard to your illustrations that you must keep in
mind at all times:

4+ As an author, you must aspire to create illustrations for your book to tell your story visually
in an amazing, compelling and inspiring way. You hope that as the parent reads a child
your book, the child is taken in by the visuals, the artwork that children respond to.

4+ Whether you are writing your first book or producing a series, your illustrations are setting
a standard that can make or break your success. As a children’s book author, your
illustrations define your brand.

4+ Itis important that you establish a “look” right from the start that can carry on in sequels,
future projects, product development and more. You don’t know how inspiration is going
to flow. A book you think of as a one-time thing could inspire a series of books based on
the same characters; or a series could inspire an animated children’s program or physical
products like dolls. Of course all of our projects are not going to turn into that, but I've
always found that it is better to think long-term and plan big in the beginning rather than
embrace small thinking and have to back-peddle down the road.

The lllustration Process

So you have a great little story...Whether creating books for Kindle or for print, and whether
you are creating the illustrations yourself or hiring a professional illustrator to whom you need
to communicate your vision, there is a process involved in illustrating your books. A lot of
factors go into the illustration process before you begin to create the actual illustrations:

* lllustration PLANNING: What elements of your story should you illustrate? It won’t be
everything so what needs to be illustrated?

- Some of this will depend on the age bracket you are targeting. If you are writing a book
targeted at the age 4-8, you are going to have more illustrations than if you are targeting
8-12. Books written for ages 8-12 are likely to have one or two illustrations per chapter
where a book for 4-8 is going to be fully illustrated with full-color illustrations.

- Where are the natural breaks in the story?

- What visuals is your story going to create?
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* lllustration STYLE: What “look” are you after? We are talking about your design style. Do
you want it to be modern? Exaggerated like animals with giant heads and tiny bodies?
Painterly? Minimalist, etc.?

* lllustration COLOR SCHEME: Color palette must be consistent throughout the entire book!
The worst mistake you can make is to have one illustration look one way, say muted earth
tones and a few illustrations later have bright, neon-looking one. You have to decide on a
color palette and stick to it throughout the entire book and/or series. Is that color scheme
going to be earth tones? Monochrome? Bright, primary colors, etc.?

* lllustration MEDIUM: This is often related to style. Each medium has a totally different look
and feel to it. What is going to fit best in telling your particular story? When it comes to the
illustration mediums, you have several options:

- Traditional mediums: Acrylics, Gouache & Watercolor are the most common used for
illustrating children’s books

- Computer-based mediums: vector (cartoons),
raster (all digital photos, pixel-based) & 3D art
(modeled using 3D programs)

- Photography-based mediums: photograph
imported into computer and then using digital
art filters (image right). We live in a time when
the software available to us is practically
miraculous. What you can do with even apps
on your phone today were impossible to do
ten years ago. This is a great age for creating
information products, books, and more.

* lllustration SPECS: What specifications does your book require?

- Final Image Resolution: where is your final image going to be? Print? Digital eBook? If you
are going to print, you need to know your page size and your images must be 300 ppi so
image size is going to be page size x 300. If you are going just to Kindle, your image is
800 pixels wide at 72 ppi. With some of the newer Kindle versions, some would argue that
the image could be wider and that is probably true, but if you want to remain compatible
with the broadest number of Kindle devices, 800 wide is a good place to start.

Remember, the bigger the image is, the larger the download size and the greater the risk
of increasing download delivery charges.

- Aspect Ratio: what is your page width vs. your page height. If you are printing, your
illustrations need to match your page size! Unless you are trying to create illustrations that
only take a smaller portion of a page, you don’t want to create illustrations that are
horizontal and then try to fit those into a vertical frame. If you are using Kindle, the Kindle
aspect ratio is 1:1.6 so that means the long side of your page is 1.6 times the size of your
short side.
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- ALWAYS plan for the largest size! Many of you are likely just Kindle publishers who
haven’t done much in print and may even think you are never going to print. First of all,
you should be creating books for print. You cannot take advantage of opportunities like
Amazon’s Matchbook program if you are not creating books for print. Furthermore, there
is something about having a print book, especially for children’s books, and with the color
options available through CreateSpace and other printers, there really is no reason why
you shouldn’t create a print edition for your book. All of this is to say you have to plan for
the larger size. Not only are there different book type options, but you will need web
graphics and Facebook images of your illustrations. There are also ancillary products like
posters and calendars, greeting cards and apparel you can create. If you have amazing
illustrations, chances are good that people are going to want them in a form beyond the
pages of your book. You can take a high-resolution image created for print books and use
it for other products or easily reduce the size for a Kindle device, but you cannot take a
small illustration created for a Kindle device and turn it into a print version or use it for
much else without literally starting over and recreating the illustrations! Can you imagine
creating a book for Kindle that just takes off with thousands of downloads every month
and people asking for a print version when you only have an image 800 pixels wide? Even
if you think you will never create a print version of your book or an ancillary product, you
cannot guarantee you won’t change your mind in the future so always create your
illustrations in the larger size so you are ready for whatever the future might hold.

CREATING ILLUSTRATIONS

Once you have planned for your illustrations and know what it is you want and need, where
do you begin to create your illustrations? First and foremost, know and understand your
options for getting your illustrations produced:

» Draw or paint them traditionally yourself. Maybe you are a talented artist who can draw or
paint your own illustrations. That’s great! That will save you a lot of money and effort in
getting the illustrations to look the way you envision them.

» Friend or family. Do they understand the process? One of the big problems I've seen,
especially in illustrations that have people in them, is the illustration of the eyes. People are
difficult to illustrate. Young and inexperienced illustrators very often do a terrible job making
eyes big and goofy looking. It looks unusual and ruins the illustration. Maybe you have that
person in your family, the one who draws all the time or is a trained artist or is an art
student whose work is amazing. That is fantastic news for you. But for most people,
“Suzy’s” doodles are not the kind of a skilled and talented artist that you need for your
brand. Now is not the time to encourage “Johnny” in his illustration dreams if you don’t
have the courage to tell him when the work is bad. This is about your book, your brand,
and you want it to look as good as you can get it.

* Find an art student in high school or college. This is a smart method and can work out
good for you. They are studying art and art styles, they want to build their portfolios, and
very often you can strike a deal with one of the top students who can do your project for a
fraction of what a top illustrator would charge. Just remember, working with students can
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present challenges. Your project is not their top priority, so you will have to manage the
process and expect delays.

» Qutsource. You can always hire a professional illustrator. Depending on the type of art you
want, you may be able to find an artist on Fiverr, but you have to be very picky. There are
not a lot of “professional” artists working on Fiverr because professionals will not work for
those fees, but you can try. Alternatively, you can find and hire a true professional illustrator.
If your story is hot and you think it is going to be a huge seller, you may want to hire a
professional for all the advantages and benefits they can bring to the table; but be
prepared... you will have to spend hundreds of dollars per illustration. it is not unheard of
for a 32 page book to cost $10,000 for a set of illustrations.

* Use photo-based illustrations. As a photographer and Photoshop junkie, | really like this
approach. I’'ve been experimenting with it for a long time and teach a number of courses on
how to use the many different techniques I've developed. Once you take your photos, you
have lots of options for converting them to illustrations. You need to know how to properly
use the techniques to get a desired end result, but there are a lot of options.

Photo-based lllustrations

A book published in the early 2000s inspired me along the path to create illustrations from
photographs. The book, Stranger in the Woods, was a children’s story created by two
photographers who built a snowman in the woods and over the course of a winter, they were
able to photograph various scenes like little deer interacting with the snowman. The
“illustrations” in the book are all photographs. | thought it was amazing that they could use
photographs in place of illustrations for a book that became a huge best-selling book and
won a boatload of awards. Once | saw some of the new software technology that was coming
out where you could turn photos into illustrations, it all just clicked.

There are basically two methods used to create a photo-based illustration:

- “Live” Photos: the entire scene is shot in picture form, either staged or not. You set up
the scene live, take a photograph, and that picture becomes your illustration, either “as
is” or as a photographic “illustration” using software manipulation techniques.

- Photo Composite: take multiple elements—like multiple photographs, photographs and
3D models, etc.—and bring them together to create the scene in an image editor like
Photoshop. The images below show the basics of creating photo composited scenes.
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The image on the right is a photo composite for a book | am illustrating. The story is based on
a dog’s interactions with various other animals. The odds are slim that | could photograph the
dog interacting with a mountain lion in a way that would be acceptable for a child’s book. So,
for that book, | am modeling the characters in a 3D program (left). | found a photograph in a
stock photo site that | thought would work good in a particular scene in the story (center). On
the right, you see the result of me compositing these two elements together and then
applying some of the illustration techniques | use to get the end result.

ADVANTAGES OF PHOTO-BASED ILLUSTRATIONS

Photo-based illustrations change the rules. Photographs are the most commonly used visual
medium for telling stories. Most people take and use photos EVERY day, especially with their
phones. Why? Because we see something that is cool or we are having an experience that we
want to remember, etc. We want to capture those memories so we can share the stories with
others. And, anyone can take a photo. It may not be a great photo, but | can fix that. On the
other hand, few can actually draw or paint in a way you would actually want to use in a book.

The process is also fast and puts control back in your hands. Sometimes, you have an idea
for an illustration but when you see it, you decide it is all wrong or you want to change the
story and the illustration no longer matches the text. Unlike with traditional illustration, using
these techniques allows you the flexibility of changing your mind, quickly and often. Have an
illustrator create an illustration for part of your story, then change your mind and see what
happens. After they freak out, they will do a new illustration and charge you all over again for
every time you change your mind. Because the techniques | am showing you are quick, when
you change your mind about a scene, you can just find a new photo, bring it into your
software, render it into a new illustration in ten minutes. That is a game-changing, low-cost
difference.

POTENTIAL FOR PHOTO-BASED ILLUSTRATIONS

You may think, “Tony, | don’t want “photographs” in my children’s books. That isn’t the look |
want.” Great! There are so many different possibilities for using photos to create unique
illustrations that you don’t have to just take a picture and slap it onto a page in your story.

Lately, I've been looking at the work of best-selling children’s book authors and then
developing methods to create digital styles inspired by the illustrations in their best-selling
children’s books, illustrations from the likes of Dr. Seuss, Eric Carle, etc. Let’s look at some
examples of illustrations I’'ve created using this method. The images below are illustrations
that have come out of my training course where | teach these methods. They represent a
wide, varied set of styles because one style is not going to work for every book.

The image below left is inspired by the work of best-selling author/illustrator, Eric Carle. It is a
photo composite of two photos that were cut apart and then, after applying filters to them,
were re-composited together again. The image right is a 3D rendered dog over a photograph
with a variety of different filters applied to the composited scene.
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In the images below, the image left is a raw photograph of one of our family dogs completely
processed with a little hand-drawn elements added to it. The same is true of the image on the
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right. This is a multiple illustration technique compiled together, but the foundational image for
this is a photograph | took a couple of years ago.

The lush illustration below is based on a photo | took in Savannah, GA. On the left is the entire
illustration. On the right, | zoomed in so you could see how cool this looks. It has the look and
feel of a watercolor painting. There are about ten to twelve specific steps you have to follow
to get this look, but it only takes about 20 minutes and the end result is pretty amazing.

£

b
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Below are two more images of covered bridges to give you an idea of the variety of styles we
can create. The bridge on the left is the same bridge as above but with a different, engraving
style while the one on the right is more of a watercolor technique.

lllustrations, regardless of the method you choose to use, will be comprised of two things:
scenes and characters. | now always approach the illustration process using the photo and
photo composite option, but photo-based illustrations require photos, photos for scenes and
for characters. To be more accurate, they require images of any kind because the same
techniques can be used with line art or models the same as with photographs. | will refer to
these as “Image assets.”
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FINDING IMAGE ASSETS

Some of you may be saying, “Photos? You are a photographer, Tony. You can take the photos
you need so it makes sense for you to use this method.” True, but it is important to make
clear that the photo-based illustration process doesn’t require you to be a professional
photographer to take your own photos. You don’t have to make it difficult, and the fact is, you
have a number of different options for getting your foundational image assets. In my Easy
Book lllustrations courses, we look in detail at all of the following sources of image assets and
how to use them in creating illustrations:

* Photo composites using your own or purchased photographs
» Public Domain/Royalty-free clip art

* Public Domain book art

* Public Domain comic books

* Public Domain patents

* Public Domain coloring books

* 3D modeling

* Photographing miniatures

Let’s take a look at a few of these options...
TAKING PHOTOGRAPHS

| think you will be surprised to learn what is required for taking your own photos when you are
going to convert to illustrations.When it comes to gear, you don’t need $1,000 cameras. |
have students who have created some amazing illustrations using nothing more than their
point-and-shoot cameras. Using high-end cameras comes with some benefits because of
things like control over depth of field, exposure, etc. but nearly ANY camera, including smart
phones will work. Start with what you have and don’t let the camera be an excuse for not
getting started.

More important than the specific camera you
use is the macro lens. For many of the photos
you want to take, you are going to need to be
close to the characters, especially if you are
doing just a head shot of a three inch character.
A camera with a macro lens or

macro setting (circled in image) —
is ideal because it enables you S———
to get closer.

You can also use extensions

tubes (image upper left) to

increase the distance from the —"c;
camera sensor to the back of )
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the lens which means you can focus at a much closer distance than you could without the
extension tubes. Most extension tubes are inexpensive and are available for pretty much any
camera on the market with interchangeable lenses.

Other options for close-up shots include close-up filters (image lower right) which just screw
on over your lens. They are available in different sizes depending on the particular thread size
for your lens; macro bellows (image lower center) which work basically like extension tubes
but because they are on a track, you have a lot more flexibility; and even macro bands and
lenses available for your phone.

A tripod is generally a great idea, particularly when photographing miniatures. Unless you
have a lot of light, in some cases you are going to have to make your exposure time longer to
get the highest quality photograph, something you need to always try for. Longer exposure
times are very difficult without a tripod.

Of course, more light is better. More times than not, | use the sun. It is the best light source
we have—and it’s free. If you are shooting indoors, very often you can set up near a window
that gets a lot of sunlight to take advantage of the sunlight. If you need to supplement
lighting, you can use a basic lighting setup with work lights you can buy at a home center, or
you can invest in a more flexible setup including a light tent and photo lights. This gives you a
more even light without harsh shadows. Unless you are going for that look, shadows can be
hard to work with in compositing, so avoiding them can save you some hassles in post.

Let’s look at a “behind the scenes” photo of how | photograph miniatures and the end result
to see what I've done with some of my miniatures. In the image below left, I've used a white
blanket on the couch, some fake snow and Christmas decorations/accessories. | shot this on
Christmas day right in my living room. The light is coming from the sun entering a big bay
window in the room. The only piece of “high tech” equipment is the light stand used to
suspend the little guy and hold him still so | could use a longer exposure. For this particular
photo, | am using a Fuji Film XT1 mirrorless camera, 56 mm 1.2 lens (about the same as an
85mm on a standard DSLR) on a tripod. From the basic setup, you can see | got a pretty cool
image (right).

! e 1
Pave a Ve Viking Chigsimay

Page 10 of 30


http://easybookillustrations.com

http://easybookillustrations.com

COMIC BOOKS

It is not secret that | love the vast content available in the public domain. From clip art to
coloring book art to art from old books, the public domain offers a magnificent resource for
finding image assets we can use freely.

Why would we want to use old public domain stories? Ask Disney. The company has 50+
major motion pictures, pretty much their entire animated classics library, including Frozen,
Tangled, etc. that are all based on public domain stories or characters. They’ve made billions
of dollars from it.

A big secret of mine is comics. | love comics. You can tell stories with comics in some very
unique ways. What you may not have known is that there are over 17,000 comics in the public
domain. That means we have access to great stories and a lot of great art, and we can
repurpose those stories and artwork however we see fit because they are in the public
domain.

One of my favorite places to go for public domain comics is comicbookplus.com. Below left is
a typical screen shot of an image from this site from Alice in Wonderland. | think you will agree
that the quality isn’t very good at all. It looks nearly unusable. But with a few minutes and a
little work, you can change it into something that looks like the image right, a totally usable
image for illustrating a children’s book.

Or, take another example, an image (below left) that is not only difficult to work with because
of the halftone dots but has been yellowed with age. Using some of the techniques | teach for
working with this type of image, you can turn it into something cool like the image below right.
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Or, how about taking a similar
comic book image and turning it
into something like this:
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Characters

In my Easy Book lllustrations courses, | teach about many different ways to find characters.
Personally, | like working with miniatures which may be the perfect answer for you in creating
character-based images.

The images below are from a coffee table book | am
working on right now. In all these photos, | used
miniatures | found in a gift shop with toys and even
garden sculptures in the creation of the scenes. |
photographed them using both the outdoors and a
tabletop light tent. After photographing the scenes, |
can apply some of the illustration techniques | use
and teach to get wonderful illustrations like the
sledding scene right.
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WHY MINIATURES?

It’s no secret that | like miniatures. Using miniatures in storytelling isn’t a new idea. It has been
around for a long time. In fact, a number of production companies in Hollywood, including
Disney, have used miniatures to create entire movies. They are using stop action to create the
movie but the idea is the same: using tiny characters in a little set and photographing them. It
is a great way to make a fantasy movie and it is a great way to illustrate your book.

If you’ve ever seen any of the Lego books, the characters in the illustrations are all created
using Legos™. The company sells package kits of the same pieces so the reader can re-
create the characters in the scenes and use them to tell stories based on the characters in
those kits. It is a brilliant marketing strategy!

Traditional illustrations allow for the artist to create fantasy worlds and stories not limited by
reality or concept, but chances are you and | just cannot draw and paint like that. The number
of people who can is very small compared to the number of people who want to create
children’s books. So for the rest of us, miniatures are a brilliant option affording us that
opportunity to create fantasy worlds that we can then capture in photographs.

One of the biggest challenges in working with traditional art is control. If an artist creates
something for your story and you don’t like it or you can’t communicate adequately to an
artist your vision to get exactly what you want and he/she creates something that isn’t a good
fit, chance are the artist is going to have to start over or you are going to have to use a
different artist. Either way, you will incur additional cost.

Photographing miniatures as a foundation for your illustration gives you full control over the
end result. You set up the scene and take a photo. If you don’t like the angle, you move the
camera and take another photo. If you want the scene to be a close up, you zoom in closer.
Want the character in a different position? Move it and take another photo. Need a photo of a
winter scene in the middle of July? You can make it snow and create a snow scene on your
dining room table if you are using miniatures. The control is incredible.
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Another thing | love about photographing miniatures is you can create a library of image
assets. You can recycle and re-use elements over and over again for different shots, angles,
scenes and even different books, either in a series with the same characters or in a totally
different series. A tree is a tree is a tree. If you buy miniature trees, you can use them over and
over again in your scene set-ups. You can use your characters again and again to create a
series of books based on the same characters by just placing them in different scenes. The
characters will always have the exact same look and feel because they are the same
characters, something that is difficult using traditional illustration methods.

And when you use miniatures composited into scenes or photographed into scenes you
create on a tabletop, there is no travel necessary to get that perfect shot. But if you do travel,
it is easy to photograph miniatures anywhere! | have a series of characters | work with that |
have photographed all over the country. They are small and fit easily in my suitcase. Many of
the photos were shot outdoors with what was available to me at the time.

When it comes to the illustrations, is easy to illustrate your stories using miniatures because:

4+ It is one of the fastest ways to illustrate your book. You can literally illustrate a book in a
day.

4+ You are not limited by high-end camera gear. As a professional photographer, | have it all,
yet some of my favorite photos | have were taken with my iPhone.

4+ You can use photographs as-is or convert them into illustrations using paint programs.
One of my personal favorites is GMX PhotoPainter, http://gertrudisgraphics.com, an
inexpensive but effective program. You actually paint brush strokes in a way that is like
cloning and you have a lot of control over brush strokes, density, etc. It gives you a lot of
flexibility. Below is an example of one of my images in the painting process using it.
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FINDING MINIATURES

When it comes to miniatures, one question always comes up: “Can | use any toy or
miniature?” No, you cannot. Some are protected by copyright and/or trademark. You cannot
use popular, trademarked characters! Any brand you recognize like Disney™, Warner

Brothers™, My Little Pony™, etc. is totally off the table. But, you still have a lot of options.

One of my favorite options, Etsy, will become your new best friend. There are countless
examples there of little dolls and characters. Just do a search on Etsy for “robot.” You will get
250 pages of results, so when | tell you there are a lot of potential characters on Etsy, | mean
a LOT. And the craftsmanship is first-rate on many of these. Look at this example of a little
robot that came up in my search. It is as cute as can be and there are a number of different
robot characters in this series. These could easily make wonderful characters in a children’s
book series. The artist even has a pattern you can purchase and download as a .pdf to make
these yourself.

Lirtle Robot Plush with 2 Big Red Heart,
Robot Doll, Valentine Robot
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You cannot just pick anything from Etsy and use it, however. You need to ask permission and
not everyone will give it to you. | have to say though, I've had a lot of success talking to
people who make little miniatures on Etsy, at craft shows, etc. Every time I’ve asked someone
if I can use their little toy or character to illustrate books, they’ve said “Yes.” Every single time.
That includes some bigger manufacturers like Melissa & Doug, Safari Ltd., etc.

You have a number of other options for finding these miniatures, including:

* You can commission an artist to make them for you.

* You can make the miniatures yourself if you are crafty

» Find cheap, generic, Chinese-made toys at The Dollar Store or similar store
* Find generic characters in craft stores and hobby centers.

CREATING SETS

Of course, if you are going to photograph miniatures, you need sets for them. Whether your
story takes place in a house, in the woods, under water, or in outer space, your characters
need some kind of sets to be positioned on if you are going to photograph them for use in
illustrations.

Scenes can be created in the great outdoors or indoors using found objects, landscape
scenery for model railroading, play sets, craft supplies, generic Christmas decorations and
generic pieces from Christmas villages, etc. Look around your house. You will be surprised at
some of the things you can turn into components of your miniatures scenes.

One of the big differences between photographs and illustrations is the level of detail. One of
the things | teach throughout all my Easy Book lllustration trainings is “reduce, reduce,
reduce.” Reducing detail is the name of the game when converting photos to illustrations. So,
you don’t have to build a lot of detail in your sets like you see in the elaborate scenes of stop-
motion video.

Below are a couple of examples I've created using miniatures. The examples below are just
little sets | made for fun, not for commercial use. The image left was set up in a light tent in
my basement and the one on the right was taken outdoors.
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Scenes: Using Hollywood Secrets

When we think of illustrating our children’s books, we usually assume that for a 32-page
book, the industry average children’s book size, we will need around 28 different illustrations.
If you are planning to have your book illustrated by a professional, you are probably sweating
right now with the thought of the cost for 28 illustrations. But, even if you are going to
illustrate the book yourself using one of the methods | outlined earlier, you may still find
creating 28 different illustrations to be daunting task.

What if you didn’t have to “create” all 28 illustrations from scratch in the traditional sense?
What if you could create maybe four or five scenes and yet still be able to create all 28
different illustrations the way Hollywood does for animated films?

For 100 plus years, Hollywood has been creating cartoons using specific methods. If you ever
watched Saturday morning cartoons or other classics like Winnie the Pooh, The Jetsons,
Bugs Bunny, etc. you’ve seen their secrets in action.

Historically (it doesn’t work like this now), 2D animation techniques work with two parts:

1) The Background which is usually traditionally painted, generally acrylics, gouache or
watercolor.

2) The Cel where characters are hand-painted on clear acetate which is positioned over the
background. A separate cel or layer is created just for animation of eyes, mouths, etc.

To get the movement in the characters, the cel would be repainted with a different character
position. The background remains the same throughout numerous scenes but the cel is
changed over the background to get a completely different look. To simulate a character
talking, only the cel with the mouth changes.

Animation CellLayer
(Mouths, ete.)

Hold Cell ayer
(Character 2)

Hold CallLayer
(Character 1)

_ ' Background Layer

Cel Animation
Concepts
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You have to think that after 100+ years of creating tens of thousands of cartoons, all the
studios like Disney, Hanna Barbera, etc. created some methods that would save them time
and effort. After all, Hollywood 2D animation can require more than 50,000 cels for a full-
length movie! Time and work requirements would have demanded the most efficient methods
possible because they wouldn’t want to take five years to do a 30 minute cartoon.

What if we could borrow some of those scene building and animation techniques used by
Hollywood to dramatically speed up our illustration creation process for our books? We can;
and it will save us a LOT of time when it comes to illustrating our books.

Again, think about the specific factors:
* The backgrounds are static while the animation is created from the cels.

» Larger backgrounds are created so that close-ups, camera pans and pull-backs are
possible.

The image below top is an example from Bambi. Image bottom is a watercolor background
from Winnie the Pooh. Notice the backgrounds are long, multi-page/canvas images put
together to use for the cartoon. One background represents multiple scenes, and the
characters move throughout the area depending on the scene.
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You wouldn’t see the entire background in every scene. You would see closeups of a specific

area in the larger, overall background and the characters would play out their scenes in those
close ups.

Let’s look at a specific example in closer detail. The example below is a scene from the Bugs
Bunny cartoon, Hiawatha. This is the entire background scene that was created for a segment
of that cartoon. | went to the cartoon and pulled some screen captures off to show you how
they use this one background to create an entire sequence of cartoons.

5 \
’o
" . e

SIS

- -2 =
- -v et
| MJ"}
B

Each of the images in this sequence looks like a different ‘.‘

illustration, but when you look at the larger background, you - n . b 4

can see they are all part of the same painting. The animators | N
only had to paint one background in order to create a -l
sequence of images. Below are different examples —Bugs 9
Bunny and Mickey Mouse—of the same kind of sequences
using different character positions over a single background.
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These are the exact same methods Hollywood uses to create books that go along with their
movies and cartoons. They simply pull out scenes from the animated film and use those as
illustrations for the book.

It is possible for us to use this exact same method to create illustrations for a children’s book.
| teach an entire course on just this topic and the multiple ways to create these scenes.

Let’s put some of this information together into a step-by-step
demonstration to show you how [ create illustrated images for a children’s
book using miniatures along with a large, Hollywood-style painted
background scene...
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Demonstration: Composites... Hollywood Style

In this demonstration, the entire process is as follows: 1) photograph miniatures (Ninjas); 2)
Silhouette the miniatures in an images editor (NOTE: | will be using Photoshop, but you can
use another image editor if you prefer); 3) create a background scene; and 4) combine the
miniatures with backgrounds to create an illustration.

STEP 1: PHOTOGRAPH THE CHARACTER

For photographing your miniatures, | recommend the following:

4+ Photograph the miniature in five positions as shown in the image below. This allows you to
have the minimum number of positions needed to simulate walking and other movement,
communicating with other characters, etc. You can reverse the image(s) when needed.

FRONT 1/4 TURN SIDE 3/4 TURN

4+ Take your photos against an even-colored background. This will make silhouetting them
much easier.

4+ Don’t make it harder than it has to be.
You don’t need fancy equipment. In
these images, | used a blue index card
from Walmart, light from a window and
my iPhone. Even light with minimal to
no shadows is the most critical thing. It :
will make a huge difference in the
quality of the photo and your ability to
silhouette the image quickly.
4+ Silhouette (i.e. remove the background

so you have only the character with a
transparent background) the image in an image editor of your choice. | use the
professional’s choice, Adobe Photoshop.
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STEP 2: CREATE THE BACKGROUND

The background is a series of image assets | have. I’ve simply used a variety of elements—
each on a different layer in Photoshop—to combine together and create the scene. By turning
on and off the various layers, | can completely change the look of the background (see
below). Each one is similar and feels as if it is in the same area because the style and color
scheme are the same, but look closely and you will see that each is also different and makes
the image look like a different scene.
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STEP 3: SILHOUETTE THE CHARACTERS

In any image editing program, you should have a number of options—magic wand, polygonal
lasso, etc.—for speeding up the silhouetting process so you don’t have to take a lot of time.

1. Photoshop has a tool called the Quick Selection tool which | like a lot. This tool works on
averages, so using a small brush and dragging across the blue background while holding
the left mouse button down, it selects the background color. The more | drag, the more it
selects.

2. Sometimes, it gets too aggressive in the process
and selects things | don’t want selected like part
of the character (right), but by holding the
«option/alt» key down while dragging the mouse
across the part | do not want selected, it will
subtract that part out of the selection. It is a little
bit of trial and error, but the more | repeat this, the
more the tool “learns” about what | am trying to
select and the more accurate the selection. | think
you will agree this little trial and error can save
you a serious amount of time.

3. Shadow areas can be a little tricky. Pay
attention to that. The easiest way to
prevent complication with shadows is to
eliminate shadows with your lighting
when you take your photograph.

4. Once I've finalized my selection through
this little bit of trial and error, | will have
all the blue selected. | want the ninja girl
selected so | invert the selection: Select
> Inverse (or «command/ctrl» «shift» «I»)
> copy > paste (creates a new layer) >
turn off the background (right).

5. You will notice there is a little bit of
fringing (blue color from the background
left over on the edges of the image) on
the image. There is also a bit of a cast
to our ninja girl because of the blue
background. | could have used green
screen software, but this is easier. To
address the fringing, with the ninja girl
layer selected > Layer > Matting >
Defringe and change the value to 2px.
This will average out some of the edges
and get rid of the fringe.
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| still have the blue cast to remove: Image > Adjustments >
Selective color > choose cyans in the drop down list and
turn the cyan slider to zero. The cast pretty much goes
away. Do the same thing choosing the “Blues” in the
dropdown menu, and the blues go away but there is now
some magenta in there. Turn magenta down with the blue
and cyans selected and the color casts go away (image
right—NOTE: a white background has been added to make
it easier to see the change).

STEP 4: COMPOSITE THE IMAGES

1.

3.

With ninja layer still selected, left mouse click the ninja with
the move tool (arrow) selected and drag the character over
to the background document tab and position onto the
scene. She is big so Edit > Transform > Scale to get corner
handles > drag handles while holding down the «Shift» key
to proportionally scale her to fit (see image below).

Shadows are a normal part of life when there is light
shining on a person or object, so for this scene to
look more realistic, a drop shadow makes sense. My
quick and easy way to make a drop shadow is as
follows: With ninja layer selected, duplicate the layer
(«command/ctrl» «J» or drag layer down to the icon
next to the trash can) > lock the copy layer > fill
locked layer to black (locking layer ensures the fill will
go only where there are pixels not in the surrounding
transparent area) > unlock layer; Edit > Transform >
Distort to distort layer & flatten as a shadow; Filter >
Blur > Gaussian Blur at around 9-10 px.

Shadows are not completely black so go back to the
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shadow layer (name your layers as you create them so you can find them when you need
them!). The default blend mode in Photoshop and other image editors is “Normal.” | want
to change the blend mode to “Multiply” and turn
the opacity down to about maybe 70%. Using the
move tool, | can further position the shadow to
where it needs to be for a correct light angle in the
scene.

4. With the two ninja layers selected, | can pick up
the ninja and move her and her shadow anywhere
in the scene. | can also copy her and her shadow
onto another background to get a completely new
set of scenes.

5. Just with this character, | can create several
illustrations for a story I’'ve written. If | am doing
an 8x8 book, for example, | would just crop a
scene to a square, save as lllustration-1. Then |
can move the ninja and her shadow in the scene,
crop again and save as lllustration-2, and so on
(below). In minutes, we can create four or five
images just from this one background by moving
the ninja in the scene and cropping the image. If |
had to have an artist paint those four or five images, it would take them weeks where it
took me minutes.

One of the nice things about having image assets on layers is the flexibility it gives me in
changing the scene. For example, if | had a tree on a separate layer, | could make the ninja
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walk behind the tree just by changing the layer order and moving the tree layer above the
ninja. It is that simple.

You are not limited to doing this with image assets in the background. You can do the same
thing with photographs. For example, take this photograph right, a public domain photo |
found on pixabay.com. | like to
first apply a filter to make the
photo look like an illustrated
background. In this case, | am
going to use a program called
Artista Impresso Pro which
basically takes a photo and
makes it look like a painting.
There are a lot of different
presets you can try to get the
look you like. It all comes down
to a matter of preference in the
style you choose.

Once you have made your
selection, save the background
image. Copy the painted image

Page 27 of 30


http://pixabay.com
http://easybookillustrations.com

http://easybookillustrations.com

and paste it into Photoshop onto a layer in the photograph document. | then like to turn back
the opacity of the painted layer (top layer) to say 60-70% in order to get some of the detail
from the photograph but still have the painted effect.

Now, | have a background | can use to drag my ninja girl and place her with her shadow into
this scene. Now instead of being in the vector asset forest, she is in this kind of painted forest
(below)—and it is all photo based.

Repeat the same exact silhouetting procedure with the front facing ninja photograph. Place it
into this scene. Duplicate the ninja character layer several times, resizing each one to a
smaller and smaller image. Then, you can create a series of images where you create the
illusion that the ninja is farther off in the distance and appears to be walking closer to the front
of the image because her position is changing and she is getting larger as she gets closer
(see series below).

Page 28 of 30


http://easybookillustrations.com

http://easybookillustrations.com

Maybe you don’t want to do this process using photographs of miniatures. That is okay. You
can do the same thing with clip art.

Go to openclipart.org, a public domain site, search
for a character you like and download the png
(transparent) file. Open this already silhouetted file
and going back to the original scene we built, drag
the character onto the background and resize.
Repeating the same steps we did before, we can
position our character in the scene. Add all the
characters you want in the same manner. Ideally,
you want to find characters that have more than
one pose, but even with static characters, you can
reposition them to get multiple scenes.
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| want you to remember some things when it comes to illustrating your children’s book...

4+ Some of my students who have gone through my training courses on illustrating children’s
books have created some amazing illustrations. Many of these people never imagined they
could get a children’s book done before they learned these techniques and now they are
on Amazon selling books.

4+ These methods don’t require a huge amount of time or cost. The DO require planning and
some skill, but these are tasks anyone can learn and do easily.

4+ ANYONE can illustrate their own (or someone else’s) children’s book using miniatures.
Hopefully, from the examples I’'ve shown here, you can see how powerful this can be,
especially if illustrations are the thing holding you up from getting your book done. Yes,
you will have to craft some sets and learn some photo editing skills, but these are things
you can pretty easily learn. The beauty is you are not limited if you don’t like a scene the
way you are when using traditional illustration.

There is an unlimited opportunity for creativity once you determine
what you want the look and feel of your images to be so get started
illustrating your own children’s books now.
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